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Abstract: Approximately seventy one percent
(70.9%) {1} of the surface of the Earth
comprises seawater. Evaporation of seawater
controls the moisture content of the atmosphere.
The moisture content of the atmosphere controls
the clouds, the cloud structure and ultimately the
local and global climate through the mechanism
of heat transfer by conduction, convection and
radiation. All of these mechanisms are ultimately
controlled by the properties {2} and heat content
of the vast volumes of seawater that underlie the
atmosphere. This paper presents a methodology
that can be employed to accurately determine the
conductivity of seawater. This measurement
technique accurately facilitates the estimation of
the dissolved mineral content and also the phase
transition point of the measured volume of
seawater.
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1. Introduction

The three most important properties of
seawater are the temperature (T), the salinity (S),
and the pressure (P). Of these three properties,
the salinity (S) is in many ways the most
significant property. The dissolved salts in the
water salt solution, mostly sodium chloride, raise
the density, raise the conductivity, and lower the
freezing point of the resulting liquid (seawater)
from that of the original liquid (fresh water).

Since the conductivity of the resulting
solution  directly = correlates  with  the
concentration of dissolved salts, it is important
that a method be available that can rapidly and
accurately measure the conductivity of seawater.
The model presented herein demonstrates a new
approach to the methodology of inductive
conductivity measurement for liquids. In this
case, the liquid of choice is seawater.

2. Inductive Conductivity Measurement
Theory

This inductive conductivity measurement
technique derives from employing Faraday’s

Law of Induction {3}, in the configuration of an
O-Core transformer. The transformer comprises
a multi-turn primary coil, a multi-turn secondary
coil, and a ferromagnetic O-Core. The
transformer configuration is shown in Figure 1.
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Figure 1. O-Core Transformer Coils, Core and Circuit
Configuration.

This model is derived from the ecore
transformer model {4} distributed with the
ACDC Module of COMSOL Multiphysics. The
ecore transformer model and this model are both
first principles approximation models, in that
they incorporate nonlinearity, through saturation
effects in the BH core response curve, but they
do not calculate secondary effects, such as intra-
coil eddy currents and intra-core hysteresis
losses.

This model differs from the ecore transformer
model, in that the two multi-turn coils are
physically separated from each other and are
located on two different portions of the O-Core
(o-core), as compared to being overlaid on the
central portion of the ecore device.

The primary coil of this model has a copper
conductor. The secondary coil of this model has
a seawater (liquid) conductor (constrained by
thin, non-conductive tubing). The secawater
comprising the secondary coil is analyzed as a
simple conductor, ignoring heating effects and
the associated induced convection effects, as a
first approximation.

2.1 Transformer Theory
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The primary coil of the o-core transformer is
driven by an applied voltage source Vac {5}.
The applied voltage source causes a current to
flow in the primary coil. The flowing current
generates a magnetic flux around the coil that is
proportional to the number of turns in the coil.

Vac=-N, 49
dt

Where: Vac = Applied Voltage
Np = Number of Turns in the Primary

d ¢ = Differential Magnetic Flux
dt =Differential Time

2.1

In integral form, Equation 2.1 is:
ds -
Vacz——JB-nda 22
dt 45

Where: Vac = Applied Voltage

B = Flux Density

71 = Unit Normal Vector
da = Differential Area

dt = Differential Time

The magnetic field intensity H gives rise to
the magnetic flux density, as follows:

B=uuH 23
Where: B = Magnetic Flux Density

—

H = Magnetic Field Intensity
U, = Relative Permeability

M, = Free Space Permeability

2.2 Inductance Theory

Figure 2 shows a magnetic transformer circuit
with a primary coil, a secondary coil, a mean
core length, and a cross-section area.

Ampere’s Law states that the line integral of
the magnetic field intensity around a closed
contour is equal to the total current enclosed {6}.
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In the case where there are a discrete number
of loops, as in the case of a closed transformer
core multi-turn coil, Equation 2.4 becomes:
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Figure 2. Magnetic Transformer Circuit Showing the
Primary Coil, the Secondary Coil, the Mean Core
Length, and Cross-section Area.

Assuming that the transformer of Figure 2
has an applied load, as shown in Figure 1, then
the voltage applied to the primary coil induces a
magnetic flux in the ferromagnetic o-core. The
flux in the o-core, in turn, induces a voltage in
the secondary coil {7}:

v,=—n, 9 2.6
dt
Where: Vg = Induced Voltage
Ns = Number of Turns in the Secondary
Coil
d ¢ = Differential Magnetic Flux
dt =Differential Time

Since the secondary coil, in this case, has
significant internal impedance, the induced
voltage will be divided between the internal
impedance of the coil and the external
impedance of the load resistor.
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Figure 3. Secondary Coil Output Voltage as a
Function of Seawater Conductivity Change.
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Thus, as the conductivity of the seawater
changes, the voltage developed across the load
resistor changes accordingly. Figure 3 shows the
calculated values obtained using the physical and
component parametric values incorporated into
this model.

3. Use of COMSOL Multiphysics

In the model presented in this paper,
COMSOL Multiphysics is employed to build a
parametrically swept model of an o-core
inductive conductivity measurement sensor for
seawater. This sensor model is built using the
COMSOL Multiphysics Magnetic Fields (mf)
and Electric Circuit (cir) physics interfaces.
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Figure 4. Magnetic flux density in the O-core and the
currents in each multi-turn coil.

Figure 4 shows the calculated magnetic flux
density solution in the core and the current flow
in each of the coils of the dual multi-turn coil o-
core inductive conductivity measurement sensor.
Multiple turns of copper comprise the primary
coil. Multiple turns of seawater comprise the
secondary coil.

3.1 Building the Model

Open the COMSOL Multiphysics desktop. In
the Model Wizard, Build a 3D model by first
selecting 3D. In the next step, first add the
AC/DC>Magnetics Fields (mf) interface, then
add the AC/DC>Electric Circuit (cir) interface.
In the next and final initial step, select Preset
Studies for Selected Physics>Time Dependent.
Then Click the Finish flag.

Figure 5 shows the selection steps necessary
for each geometrical item required to build the o-
core inductive conductivity sensor geometry.

The dimensions for each item, in mm, are shown
in the Appendix in Table 1, Table 2, and Table 3.

v % Geometry 1
v . Work Plane 1 (wp1)
¥ % Plane Geometry
[—1Rectangle 1 (r1)
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¥ % Plane Geometry
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> [ View 3
&y Extrude 2 (ext2)
i) Block 1 (blk1)
Figure 5. Ggmetry Build Steps in Model Builder

The o-core is the fundamental element of the
sensor and is built by first creating an xz-Work
Plane at the y-coordinate 10 mm. Two rectangles
are then built and filleted in the xz-Work Plane.
The Boolean operation Difference is then used to
form the cross-section of the o-core geometry in
the xz-Work Plane. Next, by using the Extrude
operation to add depth in the y direction by 10
mm, the solid volume of the o-core is formed.

Once the o-core is formed, it is necessary to
add the two multi-turn coils. The two multi-turn
coils are built by first creating an xy-Work Plane
at the z-coordinate -20 mm. Two circles are then
built in the xy-Work Plane. The dimensions for
each item, in mm, are shown in the Appendix in
Table 2. The first circle, cl, surrounds the left-
most vertical-section of the o-core. The second
circle, ¢2, surrounds the right-most vertical-
section of the o-core. The circles are configured
with a 5 mm layer thickness. Once the circles
have been constructed, the circles are then
converted to 40 mm long coils through the use of
the Extrude command.

A surrounding Block is then added to
complete the final step in the creation of the
model geometry. Table 3, in the Appendix,
shows the dimensions, location and orientation
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of the surrounding block blkl. Figure 6 shows
the configuration of the final geometry.

Figure 6. O-Core Inductive Conductivity Sensor
3.2 Global Parameters

Right-click Global Definitions and Select
Parameters. Enter the Global parameters that are
shown in Table 4 in the Appendix.

3.3 Explicit Selections

In order to easily configure the properties of
subsections of the model, an explicit should be
selected and named for the desired domain or
boundary being configured, as shown in Figure
7. The Core explicit is for the core domain. The
Primary Winding explicit is for the primary
winding domains. The Secondary Winding
explicit is for the secondary winding domains.
The Windings explicit is for all winding
domains. The Primary Insulation explicit is for
all the insulated primary boundaries. The
Secondary Insulation explicit is for all the
insulated secondary boundaries.

¥V A Model 1 (mod1)

V = Definitions
@% Core
r@% Primary Winding
@;b Secondary Winding
l'5*;]5Windings
%, Primary Insulation
@% Secondary Insulation

Figure 7. Selected Geometrical Explicit 1 - 6

3.4 ACDC Magnetic Fields User Interface

The first necessary step, when using the
ACDC Magnetic Fields User Interface, is to
determine the Discretization of the Magnetic
Vector Potential. Click on the Show button in the
Model Builder Toolbar and be sure that
Discretization is checked.

v M Magnetic Fields (mf)

b " I Ampeére's Law 1
» "5 Magnetic Insulation 1
> " Initial Values 1
P> IAmpeére's Law 2
V¥ Multi-Turn Coil 1
V . Automatic Current Calculation 1
P milnputl
Pz Electric Insulation 1
-;-TEquation View
=:-TEquation View
v Multi-Turn Coil 2
V¥V . Automatic Current Calculation 1
P ailnputl
P = Electric Insulation 1
=::fEquation View
-;-TEquation View
» _Gauge Fixing for A-Field 1
Figure 8. Magnetic Fields User Interface

Click on Magnetic Fields (mf). In the
Magnetic  Fields  window, under the
Discretization tab, select Linear {8} from the
Magnetic vector potential pull-down menu. This
action changes the magnetic vector potential
from Quadratic (default) to Linear.

Figure 8 shows the following steps used to
properly configure this model.

Right-Click Magnetic Fields (mf) > Select
Ampere’s Law. In the Ampere’s Law settings
window, use the Selection list and Select Core.

Right-Click Magnetic Fields (mf) > Select
Multi-Turn Coil. In the Multi-Turn Coil settings
window, use the Selection list and Select
Primary Winding. In the same window, locate
the Coil Type and Select Numeric from the pull-
down menu. Insert Np in the number of turns
edit field. Select Circuit (current) from the Coil
excitation pull-down menu.

Right-Click Magnetic Fields (mf) > Multi-
Turn Coil 1 and Select Automatic Current
Calculation.
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Right-Click Magnetic Fields (mf) > Multi-
Turn Coil 1 > Automatic Current Calculation 1
and Select Input.

In the Input settings window, Clear all
Boundary Selections and Enter Boundary 22.
The location of Boundary 22 is shown in Figure
9.

Next, Right-Click Magnetic Fields (mf) >
Select Multi-Turn Coil. In the Multi-Turn Coil
settings window, use the Selection list and Select
Secondary Winding. In the same window, locate
the Coil Type and Select Numeric from the pull-
down menu. Insert Ns in the number of turns edit
field. Enter sw sigma as the value of the
conductivity of the Multi-Turn Coil 2. Enter
4.6e-5[m"2] as the area of the coil wire cross-
section. Select Circuit (current) from the Coil
excitation pull-down menu.

Right-Click Magnetic Fields (mf) > Multi-
Turn Coil 2 and Select Automatic Current
Calculation.

Right-Click Magnetic Fields (mf) > Multi-
Turn Coil 2 > Automatic Current Calculation 1
and Select Input.

In the Input settings window, Clear all
Boundary Selections and Enter Boundary 50.
The location of Boundary 50 is shown in Figure
10.

Figure 9. Primary Winding Input Terminal

Finally, Right-Click Magnetic Fields (mf) >
Select Gauge Fixing for A-Field. In the Gauge
Fixing Settings window, Select > All domains
from the pull-down menu. This choice is
necessary and avoids singularities {9}.

3.5 ACDC Electrical Circuit User Interface

In the current section of this paper, the
external circuitry is added to the inductive
conductivity measurement sensor, as shown in
Table 5.

Right-Click Electric Circuit (cir) > Select and
configure each Desired Circuit Element, as listed
in Table 5 (in sequence), as shown in Figure 11.

Figure 10. Secondary Winding Input Terminal
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Figure 11. Electric Circuit Elements

The first added element is Voltage Source 1.
On the Voltage Source settings page enter the
Node names (connection points), Vsrc = Vac and
f=nu.

The second added element is External I Vs. U
1. On the External I Vs. U settings page enter the
Node names (connection points), and Select V=
Coil voltage (mf/mtcdl) from the Electric
potential pull-down menu.

The third added element is Resistor 1. On the
Resistor settings page enter the Node names
(connection points), and Enter Rp in the
Resistance edit window.
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The fourth added element is External I Vs.
U 2. On the External I Vs. U settings page enter
the Node names (connection points), and Select
V= Coil voltage (mf/mtcd2) from the Electric
potential pull-down menu.

The fifth added element is Resistor 2. On the
Resistor settings page enter the Node names
(connection points), and Enter Rs in the
Resistance edit window.

3.6 Materials

The four materials used in this model are
detailed in Table 6 and shown in Figure 12. The
conductivity of Air is modified to 0.01{S/m] for
stability in convergence. The conductivity of the
Soft Iron Core is modified to 5.5[S/m] for
stability in convergence, also.

v &8 Materials
> #E Air_Mod (mat1)
) #E Sea Water (mat2)
> & Copper (mat3)
> #E Soft Iron (without losses) (mat4)
Figure 12. Materials

4.0 Mesh

Click>Mesh 1. In the Mesh Settings window
Select>Extra coarse from the Element size list.
Right-click>Mesh 1 Select Free Tetrahedral. In
the Free Tetrahedral settings window Select
Entire Geometry. Right-click>Free Tetrahedral
Select Size. In the Size 1 settings window,
Select>Domain and Paste 2-10 in the Selection
window. Click the Custom button. Enter 8 in the
Maximum element size edit window.
Click>Build All. The Mesh is shown in Figure
13.

Figure 13. Meshed Model

5.0 Study

v 25 Study 1
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Step 1: Coil Current Calculation
ﬂ Step 2: Coil Current Calculation 2
Step 3: Time Dependent

Figu‘re 14.- Sltudy—l Séquencé

Figure 14 shows the Study 1 sequence
followed to solve this model. This sequence
differs from those used for the ecore transformer
by the addition of the Parametric Sweep to the
calculation sequence.

6.0 Results
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Figure 15. Secondary Voltage Vs. Conductivity

Figure 15 shows that changes in the
conductivity of seawater are easily detectable
using this method.

7. Conclusions

This model demonstrates that changes in
seawater conductivity are readily measured with
an inductive methodology. For a detailed
overview of the many applications that utilize the
conductivity of seawater and other liquids, I refer
the reader to the literature.
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Table 1: Work Plane 1 Parameters in mm nu 50[Hz] Frequency
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Work | xz-plane y=10 Voltage
Plane sw_sigma 5.5[S/m] Saltwater
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Item Type Width Height Base
R1 Solid 80 70 Center Table 5: Electrical Circuit Elements
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Item Distance External Coil 3 0
Extrude 10 1Vs. U Voltage
2 (mf/mtcd2)
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Item Type Location 2
Work xy-plane -20
Plane Table 6: Materials
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